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Overview  
 
Pre-Scheduling is the first of two steps in preparing your school’s master timetable for 
the next school year.  It is the foundation on which your school will operate in the 
coming year.   
The procedures outlined herein provide you with the school set up requirements in next 
year, which will allowing you to begin entering student course options (i.e. student 
course requests).  The procedures are purposely placed in sequential order and 
therefore should be completed in the order they appear in this document. 
 
It is assumed that District and School set up in current year have been completed; this 
document does not cover these topics.  For information on these topic areas please 
refer to the Learning Resource Centre. 
 
Audience 
 
This document is intended for level 1 district support persons, school administrators 
responsible for operation of their school, and support staff that may assist those 
individuals.  
 
Objectives 

1. Create a schedule for next year including: 
a. Course Lengths and Formats (full year, semesters, terms, etc.) 
b. Course Start dates 
c. Defining grades taught at your school 
d. Non-School Days 
e. Period rotation 
f. Departments 
g. Rooms  
h. Staff  

2. Determine what courses will be offered, to whom, and how that information 
will be entered. 

3. Understand reports available to analyze data entered in preparation for next 
year. 

 
Key Concepts 

• Complete work in Next Year in preparation for Scheduling.  On almost all screens 
this requires you to select a Next Year radio button.  Before beginning each 
procedure check to ensure you are in fact working in Next Year. 

• Complete task in sequential order as they are laid out in this document. 
• To review all field descriptions use the Help function from the menu bar.   

Click Help > About > Record the Program Name > Click Help >Select Help > 
Click Search > Enter the Program Name in the Search area.  Select the 
corresponding Program Name and Screen Name from the resulting list. 
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1.0 Pre-Scheduling Section 1: Next Year School Set Up 

1.1 Introduction 
Next Year School Set up is the foundation of your coming school year. In BCeSIS you 
can work in two separate years, one is Current Year and the other Next Year.  The year 
is always based on the September calendar date (i.e. a school year starting in 
September 2007 and ending in June 2008 would have a school year of 2007).  This 
functionality allows schools to continue entering day-to-day information on students 
(e.g. attendance, marks, etc.) in current year, while at the same time preparing for next 
year. 
 

1.2 Procedures 
The following sections provide detailed information on each procedure. 
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1.2.1 School Details 
Pathway:  BCeSIS Start Screen > School > School Information > School Details (screen 1) 
 
Purpose: To check the accuracy of the information contained on the screens and set defaults 
for next school year. 
The School Details screen is composed of four separate screens that contain information 
relevant to the Pre-Scheduling and Scheduling processes of Secondary Schools.  
Screen 1: 
Currently Active Schools: The first screen would only be updated after YET and prior to the 
start of school. On the first screen check the current details for accuracy.   
 

 

1 

2 

 
Area 1: 
1. School Description – Select appropriate description 
2. Type – Used to identify your school when copying school setup to another school 
3. Sub-Type – Must be set to Regular Day School in order to be picked up by YET 
4. Home Room Assign – Your choice 
5. Attendance Type – Usually set to Period for course based schools 
6. Alternate Period Attendance – Only check if your school is doing a mix of attendance 

types i.e., Daily and Period Attendance 
7. Check the days the school has classes 
8. Course Capping – If you do not want to allow counsellors to exceed the max number of 

students per section/class select ON.  
9. Courses In Use – Must be checked for course based schools 
10. Using Course Alternates – Must be checked if your school will be using course option 

alternates 
 
Area 2: 
1. Click the Next Screen Arrow – to advance to the second screen 
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Screen 2: 
Pathway:  BCeSIS Start Screen > School > School Information > School Details (screen 2) 
 

 

2 

1 

 
Area 1: 
1. Allow Teacher/Room Conflicts? – Check this box 
2. Remove future cross enrolled homerooms on change of next Home School  – Check 

this box 
 
Area 2: 
1. Click the Next Screen Arrow – to advance to the third screen 
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Screen 3: 
Pathway:  BCeSIS Start Screen > School > School Information > School Details (screen 3) 
 
NOTE: It is not recommended you make any changes on this screen as they will affect the 
current year.  Changes on this screen should only be made after YET and prior to the start of 
school (i.e. the August timeframe). 
 
This screen shows a typical Current School Year setup.  
 

 

3 2 

1 

4 

 
Area 1: 

• The semesters, terms, days, periods and number of tumble patterns (the order 
periods will be offered during a day) are indicated. 

Area 2: 
• Tumble Patterns – the specific tumble patterns (the orders periods will be offered 

during a day are displayed. Note that although the tumble patterns are referred to as D1, 
D2, etc.  it is helpful to think of them as T1, T2, etc.   

Area 3: 
• Period and Length – must be entered.  These settings are used to determine full or 

part-time status.  
Area 4: 

• Click the Next Screen Arrow – to advance to the fourth screen 
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Screen 4: 
Pathway:  BCeSIS Start Screen > School > School Information > School Details (screen 4) 
 
This screen is used to reflect how you would like your school’s schedule to work for Next Year. 
MTB will pull information from this screen when you create your first version.  It is VERY 
important that you have this setup correctly during Pre-Scheduling.  
 

 

1 

 

 
Area 1: 
1. Year – Automatically populated. 
2. Semestered? – Must be checked for all course based schools 
3. Number of Semesters – Indicate the number of semesters your school has (usually 2) 
4. Number of Terms – Indicate the number of terms your school has (i.e. Does your school 

offer 9, 6 or 4.5 wks courses?) 
5. Number of Days – Set to 1, unless your school offers courses on alternating days.  
6. Ensure you always click the Save button. 
 
NOTE:  The remaining fields on this page are not used in BC schools 
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1.2.2 Next Year School Schedule 
Pathway:  BCeSIS Start Screen > School > School Information > Schedule > Next Year  
 
The current year schedule can be copied to the Next Year by clicking the copy button (pencil on 
a notepad).  This is useful if you will be offering the same number of semesters and terms as 
the previous year. 
Once copied to Next Year you will have to modify the dates as indicated by the Ministry’s 
Standard School Calendar 2008/09 located in Appendix A. 
 
NOTE: Be sure Start and End dates do not fall on Non-School Days.  
 

 

1 

2 

5 
4 3 

 
Area 1: 
1. Ensure the Next radio button is selected. 
 
Area 2: 
1. In the Schedule area, to delete an entire row 

a. Select the row you would like to delete 
b. Click Record > Remove 
c. That record will be deleted 

2. To Add a row  
a. Click the Add button 
b. Enter the correct Semester #, Start Date & End Date, Term #, and Start Date & End 

Date 
Area 3: The Modify Year Start Date and Modify Year End Date buttons will only be accessible 
by users with school schedule security class, check with your L1.  
Area 4: After entering each row click the Validate Schedule button to ensure setup is valid. 
Area 5: Click the Save button when done. 
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1.2.3 Course Lengths and Formats 
 
Pathway:  BCeSIS Start Screen > School >School Information > Schedule > More Info > 
Course Lengths and Formats 
 
Add all of the course lengths and formats the school will use in next year’s schedule.  You may 
want to add extras to ensure they are available later for all scheduling scenarios you may wish 
to use. 
 
Steps: 

1. Ensure the Next radio button is selected. 
2. Click the Add button to add a record 
3. Enter a number. From the drop down select a Course Length  and Course Format 
4. Save the record 

 

 

2 

3 1 
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1.2.4 Course Start Dates 
 
Pathway:   BCeSIS Start Screen > School >School Information > Schedule > More Info > 
Course Start Dates 
 
Course start dates must be entered.  Ensure you are working in the Next Year screen. 
This screen is pulls information entered in the previous steps (i.e. School Schedule and 
Course Lengths and Formats). 
 
Steps: 

1. Ensure the Next radio button is selected. 
2. From the Course lengths drop down field select a length (e.g. Full Year Course) 
3. Click the ? a list of start dates will display.  These are dates in which you indicated a Full 

Year course, Semester courses or Term courses can start.  Select the appropriate start 
dates for each Course Length selected in step 1. 

4. Repeat this step for each Course Length created 
5. Save the record 

 
Note: Ext. Code and State Report Term are not used in BC 
 

 

2 

1 
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1.2.5 Grades and Catchments 
 
Pathway:   BCeSIS Start Screen > School >School Information > Schedule > More Info > 
Grades and Catchments 
 
Ensure you are working in the Next Year screen. 
 
Note:  Next Year Associated Catchments boxes are not used in BCeSIS 
 
Area 1: 
1. You can click the Copy from Current button if your school will have the same grades as 

last year. 
2. You can also add or delete grades if your school is changing for the coming year, by clicking 

the Add or Delete buttons. 
a. After clicking the Add button, select the Grade from the drop down (Area 2). Select the 

row you would like to delete 
b. To delete a grade select (highlight) the grade you would like to delete and click the 

Delete button. 
 
Area 2:  Lists all grades to be taught at your school in the coming year. 
1. Unavailable periods – you can specify periods to be unavailable for certain grades (Not 

commonly used in BC schools) 
2. Last grade at School – Every school must indicate what the last grade is at your school. 
3. Include GR, GA, SU and HS, to ensure Mass Registration will work next year. 

 

2 

1 
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1.2.6 Period Start and End Times 
 
Pathway:   BCeSIS Start Screen > School > School Information > Schedule > More Info > 
Period Start and End Times 
 
This screen is only used for the Find Student function. 
 
Note: It is recommended that you do not use passing time between periods, this way you will 
always be able locate a student (as shown in the example below). 
 

 

1 

3 

4 
2 

 
Steps: To add a Period Time 

1. Select the appropriate grade from the Query Grades field (select All if your school only 
has one bell schedule for all students) 

2. Click the Add button 
3. Enter the Period #, enter the Start Time, enter the End Time 
4. Save the record 
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1.2.7 Non-School Days 
 
Pathway:   BCeSIS Start Screen > School > School Information > Non-School Days 
 
Ensure you are working in the NEXT YEAR screen. Non-school days are those days in which 
attendance will not be taken. 
 

 

32

4 
1 5 

 
Steps: To add a Non-School Day 

1. Click the Add button 
2. Enter the Non-School Date 
3. Select a Reason (these are created on the SYS320 screen Administration > System 

Codes > School > Non-School Days) 
4. Save the record 

 
Copying Non-School Days 
 
Once Non-School Days have been set up at one school they can be copied to all other schools 
in the district or just to schools of similar type (e.g. Course Based schools). 
 
Steps: To copy Non-School Days to other schools 

5. Click the Copy button 
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6. From the Copy to all Schools of Type drop down list, select the type of school you 
would like to copy to. 

7. Note:  Non school days found at destination which do not at exist at this school will not 
be affected. 

8. Click the Copy button 
 

 

Ensure that the Next Year 
radio button is selected! 

7 Note 

6 

8 
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1.2.8 Create and/or check Departments 
 
Pathway:   BCeSIS Start Screen > School > School Information > Departments 
 
Department is a required field in Course Maintenance therefore they must be setup (i.e. when a 
course is brought down to the school level a Department must be entered to save the course to 
that school).  Department codes can be alpha, numeric or a combination.  Each code must be 
unique. 
 
Some large schools may find it advantageous to create sub-departments for example: Science 
Department could have sub-departments of Biology, Chemistry, Physics, etc.  This can be 
useful when generating reports.   
 

 

2

3 4 
1 

 
Steps: To add a Department 

1. Click the Add button 
2. Enter the a Code, Description and Dept. Category Code 
3. Save the record 

 
Departments can also be copied to other schools, in the same way we copied Non-School 
Days. 
 
Steps: To Copy Departments (As this activity must take place in current year, be sure this 
activity has no negative impact on the schools being copied to). 

4. Click the Copy button 
5. From the Copy to all Schools of Type drop down list, select the type of school you 

would like to copy to 
6. Click the Copy button 
7. Save the record 
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1.2.9 Create and/or check Rooms 
Pathway:   BCeSIS Start Screen > School > School Information > Rooms 
 
Room Maintenance table is used in both current and next school year.  New rooms can be 
added in preparation for next school year’s schedule.  Rooms that will not be used next year 
may only be deleted from this table after YET.   
 
Note: Capacity here is not used for scheduling, it relates to fire regulations 
 

 

2 

3 
1 

 
Steps: To add Rooms  

1. Click the Add button 
2. Enter the a Code, Long Name, Ext. Code, Capacity and Room Type 
3. Save the record 
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1.2.10 Create and/or update Staff Maintenance 
Pathway:   BCeSIS Start Screen > School > School Information > Staff Maintenance 
 
From this screen users can add or delete teachers for the next school year.  Once records are 
attached to a teacher (i.e. sections), they can not be deleted.  Therefore delete teachers prior to 
scheduling them. To prepare for next year’s scheduling activities it is necessary to copy the 
current year staff to next year. 
 
 

 

2 1 

5 
3 

 
Steps: 

1. From Area 1 select who you would like to view Teaching Staff, Non-Teaching Staff or All 
Staff. 

2. Click the Next radio button.  A message appears when there are no staff records for 
next year “Copy currently displayed staff to next school year?” Select YES. 

3. Update staff for next year by clicking the ADD or DEL buttons, as required. 
4. The following fields are required on the Staff Details page: 

a. Last Name 
b. Initials: 3 characters - this must be unique for each staff member.  It is 

therefore recommended that this be used as a unique ID number i.e., 001, 
002, etc. 

c. First Name 
d. Gender 

5. Click Save 
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1.2.11 Copy and/or Setup Fees 
Pathway:   BCeSIS Start Screen > School > Fee Management > Student Fee Codes > Fee 
Codes 
 
If you are currently using fees you must copy fees to next year prior to the courses being copied 
to Next Year.  If you will be using fees associated with Teams/Groups you must copy fees to 
next year prior to copying the Teams/Groups. 
 

Be aware of Ministry policy regarding applying fees to courses 
. 

 

3

2 
1 3 

 
Steps to Add fees: 

1. Click the ADD button.  Enter all relevant information in available fields; 
2. Click the Save button. 

 
Steps to Copy fees to next year: 

3. You must be in Current year to copy fees; 
4. Click the Copy Fees button; 
5. You will be prompted with a message to proceed with copying fees to next year click the 

Copy Now button to proceed; 
6. Click OK on the two pop up windows; 
7. Click the exit door to return to the Fee Codes page. 
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1.2.12 Copy and/or Create Teams & Groups 
Pathway:   BCeSIS Start Screen > School > School Information > Teams/Groups 
 
Setting up teams and groups can be useful for recording attendance on an entire team.  For 
example if a Basketball team was going to be away on a road trip an office clerk could easily 
identify those students to mark as absent.  Teams and/or Groups may be setup to assist with 
the scheduling of special groups of students, though these can be handled in other ways just as 
easily. 
Copying Teams/Groups to the next year only copies the Team/Group structure not the individual 
members.  These then have to be copied separately.  
 
 

 

     1 

 
 
Steps to Copy Teams: 

1. In Current Year, click the Copy Teams button. 
Steps to Copy Members of a team: 

2. Once you have copied the Teams click the Members button 
Click the Next year radio button – this will copy members of a team from one year to the 
next. 
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2.0 Pre-Scheduling Section 2: Courses, Pre-Transition  and Option Sheets 

2.1 Introduction 
Now that the structure has been defined for next year you are ready to being; identifying 
the courses that will be taught; advancing students to their next grade and; have students 
begin entering course options (requests) for next year.  

2.2 Procedures 
The following sections provide detailed information on each procedure. 
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2.2.1 Create and/or Copy Courses 
Pathway:   BCeSIS Start Screen > School > Option Sheet > Copy Courses to Next Year 
 
You have the ability to choose which year you would like to copy courses from. 
 
 

 

1 

3 2 

 
Steps to Copy Courses: 

1. In Area 1 select the year you would like to copy courses from (the source year). 
2. Click the Copy button 
 
Note:  When courses are copied to next year, any courses previously created in Next Year 
will be deleted.  In other words, this process will overwrite all courses already created in 
Next Year. 
 
3. After successfully copying, click the See Courses button which displays the list of 

courses for Next Year.  At this step you can delete courses that you will not be offering 
next year.  Section 2.2.3 of this document provides steps on Adding Courses to your 
school. 
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2.2.2 Review Courses Maintenance for Next Year 
Pathway:   BCeSIS Start Screen > School > Course Information > Course Maintenance 
 
Schools will want to ensure a variety of information is setup correctly on this screen.   This 
window contains a tremendous amount of detail, which is used to define the behavior of a 
course.   
Users can view and edit details of a course, or can add/delete a course.  The List ADD button 
may be used to call the District’s Standard Course catalog from which a school may select a 
new course to add to their catalog (see section 2.3.3).  The More button calls a window of 
additional course descriptor fields (which will be discussed during Scheduling Training).   
 
Certain fields are mandatory for scheduling purposes. These are highlighted and referenced 
below.  
 
Ensure you are in NEXT YEAR. 
 

 

NOT USED IN 
BCeSIS 

 

 
1. Select the Next radio button. 
2. Course/Title: Depending on your district’s policy you may have up to 3 characters 

available at the end to uniquely identify this course at your school. 
3. Parent Interface:  This MUST be checked if you want the course to appear in Student 

Assistant. 
4. Grade Level: the grade at which the course is first taught. 
5. Option: number if left blank BCeSIS will generate one. 
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6. Format: indicate how long this course runs for.  This field must match Course Length 
7. Course Length 
8. Department indicate which department this course belongs to 
9. Min/Max Class Size cannot be blank or zero.  To create sections of a course, the 

master timetable builder will use the max field.  Using the min size field is useful as there 
is a report that can generated to identifying those courses which have a minimum 
number of students requesting it. 

10. Report Card Narrative the text entered here will appear on the Narrative section of 
Student Assistant in addition to the report card 

11. Once you have populated all fields ensure you click the  icon to commit your 
choices. 

 
To review all field descriptions use the Help function from the menu bar.   
Click Help > About > Record the Program Name > Click Help >Select Help > Click Search > 
Enter the Program Name in the Search area.  Select the corresponding Program Name and 
Screen Name from the resulting list. 
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2.2.3 Exploding Courses 
Pathway:   BCeSIS Start Screen > School > Course Information > Course Maintenance 
 
Exploding course functionality is used to keep groups of students together through several 
courses. This is most often used at the grade 8 level for elective wheels.  For example you have 
grade 8 students taking Drama, Career and Personal Planning, Home Economics and 
Information Technology, which are each 9 weeks in length and you would like the students to 
stay together as they take each course in a term. 
 
There are two sets of courses that are used to setup the Exploding functionality, referred to as: 

1. Host course  
a. Acts as a placeholder during the scheduling process; 
b. You can choose to keep the host course and report marks on it or not; 
c. Should have some kind of indicator that it is a host course, by including, for 

example HST in the course code, XAT--08HST; 
d. Students are given a course option for ONLY THE HOST COURSE; 
e. The host course is setup with a length and format that reflects the overall length 

of all the elective courses. In the above example where a section of each course 
is 9 weeks in length, the host course must have a length of Full Year.  The 
Format will depend on if you want the students to attend the course everyday or 
on alternating days; 

f. During the simulation process, students will be placed in a section of the host 
course; 

g. This host course is then ‘Exploded’ into the subordinate courses. 
2. Subordinate courses 

a. These are the elective courses that the host course will ‘Explode’ into; 
b. Each subordinate course is setup with a length and format that reflects how long 

and how often the students will take the sections of the course.  Following the 
above example each subordinate course section would need to have a length of 
9 wks and a format of Full Term. 

c. These courses are ‘Attached’ to the host course using the More button on the 
course maintenance screen of the host course.  

 
The table below shows a typical layout of 4 sections of 4 courses offered over 4 terms.  It is 
highly recommended that you create a similar table to plot out your elective wheel.  This table 
will be invaluable when it comes time to schedule sections of your courses. 
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The following pages provide screen shots illustrating the above example. 
 
Setup of a Host course, this course will disappear after it is exploded.   In this example we do 
not want to report on this course.  
 

 
 
Example: 

1. An XAT course was used, and HST was added at the end for easy identification later. 
2. There was no Mark/Grade Type setup as marks will not be reported for this course. 
3. The Format is set to Full Year, because each section of each subordinate course will 

meet everyday. 
4. The Length is set to Full Year Course because each section of each subordinate 

course is 9 wks (9 * 4 =36 which equals a full year at this school) and we therefore need 
this host course to reserve ALL of those terms. Remember a student is going to be 
simulated into a section of this course and then it is going to be ‘Exploded’ into sections 
of the subordinate courses. 

5. Report Card is unchecked because we do not want this course showing up on a report 
card. 

6. Parent Interface is checked because we want the students to be able to select this 
course in the Student Assistant module. 

7. Max Sec/Per is set to 4 as there will be 4 sections of this course in a single period 
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8. Next each subordinate course needs to be setup (one example has been provided for 

reference, each subordinate course will need to be set the same). 

 
 

9. Course/Title a W has been added to the end of the course code for easy identification 
later. 

10. The Mark/Grade Type is setup as marks will be reported for this course. 
11. Report Card box is checked because we want this course appearing on the report card. 
12. Parent Interface is NOT checked because we do not want students selecting this 

course in student assistant module.  Remember students will only have a course option 
for the host course. 

13. The Course Length is set to 9 Week Course, because section of this course will end  
after 9 weeks 

14. The Format is set to Full Term, because a student will take a section of this course 
every day. 

15. Max Sec/Per is set to 1 as there will be 1 section of this course in a single period 
 
Once you have the setup completed for the host course and each subordinate course you need 
to attach the subordinate courses to the host. 
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16. In course maintenance, query up the host course  and click the More button, this will 

open the following screen: 
 

  

 

The following setup reflects this continuing example: 
 

17. After Sim button is selected because we are going to Explode this host course after we 
simulated students into a section of it. 

18. We have not checked either the Keep Host Course or the Keep Host Course Credit 
boxes because we are not keeping either of these in this example. 

19. Next click the Add button 
20. Click the ?, a pop up window will appear.  
21. Query for the first subordinate course, click the Select button. 
22. Repeat for each steps 16, 17 & 18 for each subordinate course. 
23. When completed you should have the 4 subordinate courses listed, as in the above 

example. Note the W at the end of each course code, this was done to make it easy to 
identify this course as a subordinate; it is part of the ‘Wheel’ 
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2.2.4 Bring Courses Down to your School 
Pathway:   BCeSIS Start Screen > School > Course Information > Course Maintenance > 
List ADD > District Standard Course List 
 
From the Course Maintenance screen click the List ADD button 
 

  
 

 
You will be taken to the District Standard Course List.  This is a list of courses the District has 
brought down from the Enterprise level and made available to your school.  If a course that you 
offer at your school is missing from this list, contact your L1 Support person and request they 
bring it down to the District level. 
 

 

Using the F7/F8 query 
function you can search for 
a course. 

 

 
Once the course is 
displayed, select it and click 
the Select button. 

In the example above we queried for MEN%.  This brought up all courses that have the first 3 
characters as MEN.  We clicked on MEN--09-- to highlight it, then clicked the Select button 
which takes us back to the Course Maintenance screen. 
 
Once back on the Course Maintenance screen, hitting the Tab key will populate all information 
that was entered at the District level (see section 2.3.2 for further information) 
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2.2.5 Run Pre-Transition 
Pathway:  BCeSIS Start Screen > School > Pre Transition > Do Pre-Transition 
 
This functionality affects groups of students in different ways.  Students remaining in the school 
will have their Next Grade and Next School set.  Students transitioning from feeder schools are 
automatically admitted as cross-enrolled students.  This cross enrollment record gives the 
‘receiving’ school the ability to enter course selections for these students for the next year. 
 
 
• Tip:  do individually by grade for all the grades in the school using the Admit code “re entry 

no interruptions” for each grade except grade 12  
• Click the ‘By Grade’ radio button and select a grade in the field that pops up.  If you don’t 

select a grade, the whole school will be transitioned. 
• Click Apply  
• Repeat for each grade 
• Note:  feeder schools will need to complete this process on a similar timeline to transition 

students to the receiving school so that course requests can be entered 
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• Pop up window -  grade 12: last grade in the school   

Withdraw code:  Graduated 
 

Post next School – No – most students will graduate 
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2.2.6 Pre Transition List 
After Do Pre-transition has been run, use the Pre Transition List to manage students coming 
and leaving the school.  
 
To get a list of students that have been pre-transitioned to your school, select the Students 
Coming view.  
 
The Pre-transition list can be manipulated as information on a student’s future plans are 
finalized. If a student chooses to attend a different school than is indicated on this list, simply 
update the Nx Sch. Field with the new school info. (NB. the student’s current school still owns 
the record, and would be responsible for making changes to the list) 
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2.2.7 Create Student Option Sheets 
Pathway:  Reports > Reports Tree  > 13 Timetable Building (MTB) Reports > Options 
Sheets 
 
It is recommended that this report be generated individually for each grade level. 
 

 

2

1

3 4 

9 

8 

7 

6 

5 

 
Steps to Create Option sheets for incoming students 
Note: In order to create this for incoming students, Pre-Transition must have been run at the 
students’ previous school.  

1. Ensure the year is set to the next school year and you have entered Semester 1 
2. You can choose to display either the Course Code or the Short Title.  Districts/Schools 

that have chosen to modify the Short Title to make it more descriptive often choose to 
go with the Short Title. 

3. For those students transitioning into your school set the Feeder School (NOT required 
when you run it subsequently for students at your school).  Then set the Option Range, 
this refers to the Grade Level field as set in Course Maintenance (section 2.3.2).  In 
the example above all courses designated as being at the grade 8 level will be printed 
on the option sheets. If you wanted to give students at the grade 8 level grade 9 courses 
then you would select 08 & 09. 

4. The  needs to be checked, then select the Current Grade.  In the example above we 
have selected grade 7. 

5. Printing course Down provides a much cleaner view. 
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6. This field sets the number of choices a student can enter. For example if you are only 
giving your grade 8 students the choice of choosing 4 courses then you could set this 
value to 4.  For your higher grades i.e. 11 & 12 you may want to increase this to say 8 or 
10.  If left blank the system will default to 16 boxes. 

7. You can set how the list is sorted.  Also you can choose to Exclude Students w/o a 
Next School (this will exclude those students whom, during Pre-Transition, you 
indicated have no next school) 

8. If you have entered 4 year course plan for students you can choose to print it.  Also you 
can choose to Preprint Students Course Selections, this can be useful especially for 
the lower grades where you may have already given students their required courses. 

9. Print School Instructions, if you click this check box a window (see below) will pop up.  
Here you can print instructions on how a student is to fill out the form. 

 

 

This is the SAVE button, 
once instructions are 
entered click it!!! 

  
Note: Creation of these Option Sheets can be resource intensive for the report servers.  In 
order to prevent your computer from freezing while this is running select Print in Background 
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2.2.8 Sample Student Option Sheet  
 

 

2 Then fill in the 
corresponding number in 
the box 

1 Students should check/circle 
which courses they would like to 
take 
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2.2.9 Student Assistant 
The Student Assistant module can be used to allow students to enter their course selections 
directly in BCeSIS.  See District and School set up documentation or review the Elluminate live 
web session, to ensure Parent Assistant has been set up correctly. 
 
Note:  On the login screen the title of the Module will be Parent Assistant, once a student logs 
in the title will change to Student Assistant. 
 

 

1 Both the Student Schedule and Log Off 
buttons will log a student out. 

2 Schools can enter information for a 
student to review, such as instructions 

3 Students will click the Add Course 
button to select the courses they 
wish to take (see next page) 

 
 
 
 
 
 
 

4 When students have selected all 
their desired courses they should 
click the All Done button  

5 For cross-enrolled students they 
may select the Change School 
button, which will allow them to then 
enter requests at their crossed 
enrolled school 
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Once students click the Add Course button a window will open listing all courses that had 
Parent Interface checked in Course Maintenance (see section 2.2.2).   
 
 

 
Steps to add course(s) 

1. From this window students can check those courses they want individually by 
checking the Add box and clicking the Add 1 button, OR  

2. They can check multiple courses then click the Add Checked Courses button. 
3. Once either button is clicked they will be prompted with a window indicating if 

their selections have been successfully added.  
4. Clicking the Return button at the bottom of this message will take the student 

back to the main page, where their course selections will be listed. 
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2.2.10 Option Sheet Entry  
Pathway:  BCeSIS Start Screen > School > Option Sheet > Option Sheet Entry 
 
This screen can be used to enter course options for individual students.  Typically a Data Entry 
person, responsible for entering course options for all students without verification, would use 
this screen. 
For a counselor, who is responsible for entering options and who may want to make 
modifications at the time of entry, the Student Course Selections screen would be more useful 
(see section 2.3.9) 
 

 

2 

3 

1 

4 

 5 

 
Steps to enter options: 

1. Enter the Student number. 
2. Click TAB twice this will take you to column 1 – enter the option number, click tab – 

enter the option number, etc.  
3. Once all entries are in for this student click in the next row under Pupil No.  Enter the 

Pupil No. click TAB twice. 
4. This will take you to column 1– enter the option number, click tab – enter the option 

number, etc 
5. Repeat this for a group of students then click Save 
 

Note: 
Once you click SAVE the list will disappear and you will have to use the Views Student Course 
Selections button to view, add or delete and option (see next page) 
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Below we can see a list of student options. 
You can delete and option by selecting the row and clicking the DEL button.  
 

 
 
As noted on the previous page, this is not the most efficient means of editing a student’s course 
options.  It would be more efficient for Counsellors to use the Student Course Selections 
screen. 
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2.2.11 Course Options - Student Course Selections 
Pathway:  BCeSIS Start Screen > Common View > Courses > Student Course Selections 
 
Another way course options can be entered for students individually is use the Student Course 
Selections, screen in NEXT YEAR.  On this screen you do not use the option number; instead 
the Course/Title is used. 
 

 

1 

2 

3 

 
Steps to enter Options for next year: 

1. Query for the student 
2. Under the Course column enter the Course/Title. 
3. Save the record after entering information for each student. 

 
 



Pre-Scheduling                                              
 

Version 1.3 Page 42 of 57 Revision Date: Dec 30, 2008 
 
 

2.2.12  Mass Entry of Courses 
 
Pathway:  BCeSIS Start Screen > School > Option Sheet > Mass Entry of Courses 
 
Rather then enter course selections for individual students you may want to mass assign 
selections, for example all incoming grade 8 students. 
 
Note: This screen automatically goes to next year. 
 

 
 

1 

2 

3 

4 

 
Steps to Mass Enter Course Selections: 

1. In Area 1 the Student Search Criteria, select Next Grade (08) and criteria such as 
Current or Next Year Grade, Home Room, Program Type, or Team. 

2. Once specified, the Search button populates a list of all students matching the criteria 
and they appear in Area 2 the Students. 

3. Click the Add Course button in Area 3, to add courses to this group of students (or 
Delete a course from the selected group).  When you click the Add Course button a 
new window will open allowing you to query for the course(s) you would like to add (see 
below) 
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In this example we have selected the following grade 8 courses English, French, Math, Social 
Studies, Science, and PE by placing a check in the Add? box. 
 
 

 
 
Click the OK button once you have selected all the courses.  This window will close and you will 
be returned to the Mass Entry window. 
 

1. In Area 4 (see previous page) you can choose to apply the course(s) to a Selected 
group of students by putting a check beside their names or you can apply the course(s) 
to All students. 

2. Click the Apply button. 
 
Important Notes: 

• When selection is from Next Grade, pre-enrolled students to that grade for next year, 
with an admission date greater than or equal to next year’s start date, will be included, 
as well as students who have been cross-enrolled through the Pre transition process. 

• The column entitled ‘PE’ (Pre-Enrolled) will display a ‘Y’ if the student is pre enrolled.  
• You are able to sort on all columns. 
• Students who have NOT been processed by Pre-Transition will not appear on the list of 

students. 
• Please note, even if students have had options entered for Next Year and the Cross 

Enrollment record was created, if they have not been Pre-Transitioned, they will not 
show up. This occurs because the Next Grade / Next School fields are not populated 
until Pre-Transition takes place or these fields are manually updated on the Pre-
Transition List screen. 
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2.2.13 Class Transfer 
Pathway:  BCeSIS Start Screen > School > Scheduling Utilities > Class Transfer 
 
This screen can be used for more than class transfers!  It can also be used to: 

• Mass Assign groups of students a course option (one course at a time); 
• Mass Remove a course option from groups of students; in fact it is the ONLY screen 

available to mass remove course options. 
 

 

1 3 

2 

 
 

Area 1: This area is used to define your Student Query choices: 
1. School Year If you want to work in current year or next year.  Remember the 

work of Pre-Scheduling is done for next year. 
2. Load Type defines how you want to bring up students.  Choices are by 

Class, Course, Homeroom or Team.  
NOTE: You can also bring up students by Grade – this is CURRENT YEAR 
grade – even if you have next year selected above! 
3. Load Value the LOV (List of Values) changes based on the Load Type 

defined in the previous step. 
4. Once you have defined the your Student Query criteria click the Load 

Students button 
NOTE: IF you have simulated students into sections of courses clicking the 
UNSCHEDULE ALL button will remove the students ENTIRE schedule --- Not just the 
course selected in AREA 3 
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Area 2: Results of your query are displayed in this area.  With in this area you can do the 
following. 

Add or Delete Students  
Check put a check beside the students you want to add or remove a course from 
Clear Students – This will remove all students from the list 

 
Area 3: Select the Course you would like to Add 

Click the  icon to the right of the Course 
field 
This will bring up a list of all courses 
Scroll or query for the course you would like to 
add 
Select the course 
Click OK 

 
 
 
 

 Click the Add Course button 
 
 
 
 
 



Pre-Scheduling                                              
 

Version 1.3 Page 46 of 57 Revision Date: Dec 30, 2008 
 
 

3.0 Pre-Scheduling Section 3: Analyzing and Preparing for the Next Step 
 

3.1 Introduction 
BCeSIS has many reports that can assist users during the scheduling process.  It is 
recommended that the Reports area be reviewed to identify reports you may find helpful. 

 

3.2 Procedures 
The following sections contain samples of some reports users may find helpful both during 
the tasks of Pre-Scheduling and after; to vet course requests and prepare to schedule their 
school.  Each report has a parameter screen that will define what information is generated.  
Please ensure you try different parameters to run the reports.  
 
The reports are presented in a logical order in which you would run them. 
 
For example there is no point in the school scheduler running a Course Request Tally report 
if counsellors have not first ran the ‘Four or Less Course Selections’ and the ‘Student 
Course Requests’ reports and dealt with problems identified in those two reports. 
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3.2.1 Printing Course Setup Information 
Pathway:  School Start Screen > Reports Tree > Export/Single 
 
The following provides information on how to extract course setup information into an Excel 
spreadsheet.  This is a very effective way of ensuring all courses are setup correctly and should 
be run prior to allowing students to select course options 
 
 
 

 

3 

2 
1 

4 5 

 
Area 1 Set the Export Information 
 
Area 2 Select Courses 
 
Area 3 The left side of this area displays the information you can extract.  Highlight what you 
want then select the arrows to move it over to the Selected column on the right. 
 
Area 4 (optional) You can save this extract criteria by clicking the saved extract button.  A good 
idea as you will probably want to run this several times 
 
Area 5 Once you have the information you want in the Selected column click the Run button 
 
 
See Next Page for the parameter form 
 
 
 
 
Parameter Form 
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Set your options as 
displayed in this screen shot 

Create a file by clicking the 
Save As… button 

 
 
Choose to open the file with Excel 

Click the Create Export button

Next you will want to use the Excel function TEXT to Columns and then Sort (contact your 
district support person for use of Excel to perform these actions). 
 
In this example we have labelled the column headings 

 
 
Table: 
Code: Note the XAT course has HST at the end to designate this as an Exploding Host course 
Short: This will show up on the Students Printed Schedule 
Description: This will show up on the Students Report Card 
Length: Is in number of weeks (see why it is valuable to identify courses by length in weeks!) 
Format: Y = Full Year everyday, A = Alternating Day for the length, S = Semester, T = Term  
Max:  The max class size is displayed 
Min:  The min class six 
Option Sheet: Indicates if this course is on the option sheet, note the 9 week term courses are 
not on the option sheet. 
 
You can also run the Course Description Verification report: 
Pathway:  School Start Screen > Reports Tree >14 Student Scheduling Reports > Course 
Description Verification 
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3.2.2 Four or Less Course Selections 
 
Pathway:  School Start Screen > Reports Tree > 13 Timetable Building (MTB) Reports > 
Four or Less Course Selections 
 
This report lists students with less than, greater than, or equal to, a specified number of course 
options for next year. It is excellent for Counselors to check for students with less than eight 
courses or more than eight courses and is therefore one of the first reports counselors should 
run to vet course requests. 
NOTE: Remember if you are using Exploding courses students should not have a 
request for the Subordinate courses. They should only have a request for the Host 
course. 

 

This setup will generate a 
report that is: 
• Sorted Alphabetically 
• Based on No. of Courses 
• For students with greater 

than 8 
courses/selections for 
Next Year 

 

 

We can see this student; Pia Stretch is in grade 8 
and has too many course options. 
Problems: 

1. She has two requests for English 9 
2. She has 4 electives (Drama, Choir, 

Drafting and Art) therefore 2 must be 
dropped 

 
Counsellors should be using this report regularly to vet course options.   
If course options are not correct an incorrect number of sections will be created. 
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3.2.3 Student Course Requests 
Pathway:  School Start Screen > Reports Tree > 13 Timetable Building (MTB) Reports > 
Student Course Requests 
 
This report provides a good view of all students that have requested a course 

 
 

 

You can quickly scan this list 
to see if there are students 
who should not be in this 
course.  
 
Can you spot the student who 
should probably NOT be 
taking English 9? 

 
Note: Another report to look at is the ‘Students Course Selections’ 
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3.2.4 Low Enrolment Report 
Pathway:  School Start Screen > Reports Tree > 13 Timetable Building (MTB) Reports > 
Low Enrollment 

 
The Low Enrollment Report is available to the school if a minimum class size number was 
entered in Course Maintenance > Min Class Size. This report lists the student name and 
number of the students requesting the course.  If the Scheduler decides to cancel the course 
the students can be easily contacted. 
 

 
 

 
 
This report is very valuable to assist with identifying sections of courses you may want to 
combine. 
In the example presented we can see we will not be able to offer Accounting 12 UNLESS it is 
combined with another course.  Alternately you may decide this course needs to be dropped 
and the student be given another course option. 
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3.2.5 Course Request Tally – by Department  
Pathway:  School Start Screen > Reports Tree > 13 Timetable Building (MTB) Reports > 
Course Request Tally 
 
The course request tally report can be viewed by department or by grade.  It also shows last 
year’s requests versus next year’s and it is therefore an excellent report for determining sections 
required for the next year. 

 

 

 
 

2 1 

 
Area 1 shows the current year’s requests.  The last column Total indicates the number of 
sections created lasted year. 
Area 2 shows Next Year’s requests and the number of Sections that will be created in MTB. 
 
Schools should use this report to determine the number of sections that they are going to offer 
next year. 
Remember if 1 Student chose a course BCeSIS will create a section. 
 
This is another useful report in determining which sections of which courses you will want to 
combine. 
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3.2.6 Course Request Tally – by Grade  
Pathway:  School Start Screen > Reports Tree > 13 Timetable Building (MTB) Reports > 
Course Request Tally by Grade 
 
 

This is an excellent report that gives information on sections needed, multi-grade level 
course requests, and extra seats in addition to actual requests. 
 

 
 

 
This is another useful report in determining which sections of which courses you will want to 
combine. 
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3.2.7 Parent/Child Relationships 
Once you have reviewed student course options and made adjustments, and have reviewed the 
course request tally reports and made adjustments, you are ready to identify sections of courses 
you will be combining.  In BCeSIS this is referred to as Parent/Child relationships. 
 
Parent/Child relationships are setup to enable you to offer multiple sections of different courses 
in one room with one teacher.   
 
Advantages: 

• Allows schools to offer courses with low enrolment; 
• Allows you to report marks for each course; 
• Allows teachers to take attendance as one class. 

 
Steps: 

1. Identify which sections of courses you want to combine.  
2. Identify the section to be designated as the Parent. If you are using Master Timetable 

Builder (MTB), consideration should be given to which section you set as the Parent.  
MTB will look at course options for the PARENT section only when deciding on the 
STDP; the child sections will take on the STDP of the Parent 

 
For example, if you want to combine sections of Concert Band 12, 11 and 10 because you only 
have a total of 28 students who chose one of these three courses (with the following 
breakdown): 
 

Course Section # of Options Parent 

MIMCB12 01 6  

MIMCB11 01 15 √ 
MIMCB10 01 7  

 
It would be best to chose MIMCB11 as the Parent because it has the most course options. MTB 
will look at the best place (STDP) to schedule section 01 of MIMCB11; this will ensure the 
greatest numbers of student’s course options are successfully simulated. 
 
You should go through this process for each grouping of Parent/Child relationships you will 
have.  Doing this will greatly assist you during the scheduling phase.  Create a spreadsheet 
(i.e. Excel) identifying the Parent section of the course and the Child sections of courses you will 
combine. 
 
Example: 

Parent Child 
MIMCB12 -01  

 MIMCB11 -01 
 MIMCB10 -01 

MACC-12 -01  
 MAC—11 -01 
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3.2.8 Option Verification Letter 
This report creates a verification letter with a school message and the courses the student has 
selected for next year.  Adjustments or acceptance can be indicated upon the return of this letter 
to the school 
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4.0 Appendix  

4.1 Appendix A – Standard School Calendar 
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4.2 Appendix B – 2009/2010 Calendar 
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